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1) IBM WAS V8.5 Liberty Profile - JPA &7

1. Ol ZEI0 A= IBM WAS V8.5 Liberty Profileg O|23jA JPA O ZEC|H 0| ME HAE SjEE=E B}7)
UL s HAEES QIshM BA serverxml > 7|5 Z2[Xt0AM AddE 22510 jpa-20 7|52 F7t
S

(jpal| AR0= YAHG| datasourceE O|Z8l|A DB ConnectionZ dl0Fst7| HZ0f| jdbc-40 7|sk &
Of =t&|0jof SfL|C. fESH JDBC A F&2o| 2¥2 X Z%tel JIDBC HAEE TSHA|Z| HiZt
S LICH)

5| serverm 2@ [J] TestServietjava 5 persistencexm ] @ Hello World i [J] searchlPAServiet java ' =h

f% Server Configuration: server? {server xml)

Configuration Structure AREE Feature Manager Details
Define the main contents of the configuration in this section. Set the features that are enabled cn this server.
type filter text 15 (#jdbc-2.0 Add.. ‘
[ = z 14 ':!\'jpE-ZC'
= o fi A0 oo o
-] E_:r\;lr l_Cr;n élg;.;lrratlon ® jsp-22
= = e
Remove () localCo -
HTTP HEZQIS | = & localConnector-1.0
= (%) servlet-3.0
B 22
L =704 2UHY Enablss: n/a

® 2% 201282 Down_| Enabléid byca
[J Data Source: jdbe/db2ds [7] show implicitly enabled features
[T Application: TestServietWAR - [\WARN =

[T Application: JPATestEAR

L]
& 1]
5
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2) JPA Sample 7|

1. IBM WAS V8.5 Liberty Profileg O|2dl|A JPA & HIAESH?| I5t0] ZHCEHSEA| JPA Sample Of Z2|# 0|

HE e HE=E SIASLICH HAY 2Z YoM 022 2 Z8510] New > JPA ProjectE B4R L|Ct

g3 Jawva EE - TestservietWaR ssro/comsibmosiuwleeserviet/ Testserviet java — Eclipse

File Edit Source Refactor MNawvigate Search Project Run  Window Help
=5 = | = e -~ W - Q@ - T — S - e—_Eo=1N o o (5 = = 4
2% Enterprise E ZE T Services | i =2 server xmil ¥] TestServiet jawa =2
e == ‘rj’ _— = -~ -

. 2=l TestsServietwWwaR
> he== WebSphere application Server Ws.5 L

saper ()} 5
Py T e DnaTto—generatced COoOnmMSTCIrrnacTDor sSTua
3
[T r | CH Project.. E
Showw In AlE+Shift=w » | T35 ©OSGi Application Project

- | 5 osGi Bundle Project
r Crualified MNarme Application Client Project
Connector BProject

Dynamic Web Project

EJB Project

Enterprise Application Project

IPA Project F
Static Web FProject
web Fragment Project
wieb Project

Example. .

COther. .. Chrl=-rd

2. JPA Project OFEHALZL LI ™ JPATest 2t= 0|28 {33t Target runtimelt ConfigurationE &}Chdt

#0| 283t = g2 SELCL

225 MNew JPA Project = o =)
JPA Project Tr

N _ _ IPA
Configure JPA project settings. L\/’

-

Project name: | JPATest

Project location
[F] Use default location

ocation [ CoWUsers®uwlesewliberty,

m

Target runtime

| webSphere Application Server W8.5 Liberty Profile - | l Mew Runtirme._. ]

Configuration

[ Minimal JpA 2.0 Configuration -| [ modify.. |

EAR membership
[F] Add project to an EAR

EAR project name: JPATestEAR - Mew Broject...

wWorking sets
[l Add project to working sets

@ - Back [ mext= | [ _mmish___| [ cancel

3. Source folder9| {X|E =Qlstn CIE2E ZaiskL|C}.

=
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2= reww JPA Project
Javera

Configure project for building a Jawva application.

Source folders on build path:

[ | ===
I ,JL

Fa—

=2 src

Drefault cutput folder:
build¥classes

sSdd Folder...

&=

_,_
A

i3
n
"

MNext =

10

Einish

] cancel

4. JPA Facet 3fHE =915t = DB Connections

MMBE7| 2810 Add connectiong Sl

f&@% nMew JPA Project

JPA Facet
Configure JPA settings.

Platform

[RAD JPA 2.0 Platform ~|
JBA implementation

Type: | Library Provided by Target Runtime vl

Connection

The targeted runtime is able to provide the library required by this facet. Selecting this
opticn will configure the project to use that library.

=Mone=

Add driver library to build path

ult schema from connection

i1}

Persistent class management
) Discowver annotated classes automatically

[] Create mapping file (ormxml)

@

@ Annotated classes must be listed in persistencexml

Add connection

Connect

Einish

] | Cancel
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ol ZztoM = olo|l get AXMY DB2E ALESIESR StASLICH)

Connection Frofile —

Create a DBZ2 for Linux, LUIMNIX, and Windows connection profile.

—onnection Profile Twypes:
type Filter tesct

i B2 for Linusx, LMD, and Windows H ==
ES DB2 for iS/0OS |
S DB2 for =/ OS

i

E&H Informix
E&SiIngres

SOQL Server

=N

rarme:
MMeww B2 for Linux, UMD, and Windows

Drescription (opticonall:

(@S Meww Connection Profile IR | I B =5

6. Drivers MEHS}HO| L}Q O O}Xl OFSO{E Drivers} Q002 Q2% 1o 9t

L|C}.

New Driver& 2

Properties

[F] Connect when the wizard completes est <

Connect ewvery tirme the workbench is started

=

52 rueww Connection Profile L= [ ]
Specifr a Driver and Connection Details —

G Define and select a driver from the drop-down list to continue.

Drivers: | -]

7. Driver TemplateOf|A{ IBM Data Server Driver for JDBCE £&!/5}11 JAR ListE MEH

gL L.

= rew Driver Drefinition

Specify a Driver Template and Definition MNMama

3 unable to locate JARSZip in file systerm as specified by the driver definition: 8 Prograrm
FilesWIB MW SOILLIBWjavawdb2jcc. jar.

MamesType [1aR List | Properties |

Hovailalzle driver termplates:

MMame Systerm “Wendor System Wersion
- Database
. IBM Drata Server Driver for JC DBE2 for Linux, UMD and wWindows ool

Other Driver DB2 for Linusx, UMNMEX, and Windows o 1l

Driver narmne:

IBM Drata Server Driver for JDBC and SOLJ
Drriver by pe:

IBM Drata Server Driver for JDBC and SO

(& = cCancel |

2| st

=

=
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8. JAR List0jA<| DB22| JDBC Driver jar o= =0l AX|E|0 Q= HAMNHOl QX2 HASID OK

=
=22|8

= FHEIE

I rdeww Driver Definition 7-

Specify a Driver Template and Definition Mamea

&3 Unable to locate JARSzIip in file systern as specified by the driver definition: C:wProgram
FileswWIBMWS QL LIBWavawdb2jcc jar.

[ MameType

Properties |

Crriver files:

TP rogram FilesswIB MW SOQL LIBEWjawvaWwdb2jocc jar
CowProgramm FileswIBMWSOQLLIBWjavawdbI2jcc_license_cisu=_jar

Add LARSEip.. |

Clear all |

@/‘J K Cancel I

Specify a Driver Template and Definition Mame

Specify a driver termplate. then modify details in the fields below to prowvide a unigue
name, a list of required jars, and set arny awvailable and applicable property wvalues.

[[rMame aype | JAR List | Properties |

Crriver files:
CRIB MW SOOI LIBWjawvawdb2jcc_license_cu _jar | sddd JARSZiD. ]
CRIB MW SOLLIBW i avaswdb2jcc jar e
EEdit JAR Zip._. i
Remowve JAR/ZiE |
Clear all |
> oK ] [ cancel |

IS rlew Diriver Definiticn

9. M|&E ®ME TIHO|Al Host2} PortE =QIst1 User named} PasswordS Q|24 ¢hL|C}.

H=g

I&]} rew Connection Profile = =[S
Specify a Driver and Connection Details
&9 Enter a2 user name. |

Drivers: |IBM Drata Server Diriver for JDBC and S0 - | & S
Properties
General | Tracing |. optional| =
Cratalbrase: SAMPLE
Host: localhost
Port number: SOO00

[T use client authentication
User name:

m

Password:
] Sawe password

Crefault schema:

Connection URL:  jdbc:db2:/floc alhost: S0000/SAMPLE retrievelessa gesFro =
mSernveronGetMessage=true;

] Connect when the wizard completes

[] Connect every time the workbench is started

Cancel
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10. 40| Ct E|YS ™ Test ConnectionHHES Z&I510] MAHEOZ ping0| Z|=X| ZQIgHL|C}. PingO|
MNEEOZ 2AZ LM Driver AHE ZAS| &2=5HA 74 QL|C.

& rew Connecticn Profile = I[[= [ == |

Specify a Driver and Connection Details —

Select & driver from the drop-down and provide login details for the
connection.

Dirivers: lIEIM Crata Server Driver for JIDBC and SO0 > | & M

Properties

General | Tracing | Optional | 2
Dratabase: SAMPLE

Host: localhost

Port numbrer: SO0

[] Use client authentication

User name: juwlee

Password: L2 2 X T E 3 X2 1

[#] sawe password
Crefault schema:

Connection URL:  jdbc:db2:/flocalhost: SO000/SAMPLE retrieveMessagesFro -
mServerCnGethessage=true;

[#] Connect when the wizard completes Test Connection

'ﬁ"_-_l Success

Ping succeeded!

H
=

11. MEA Holst Connection0| HAX o=z

o
1
rin
s
o

@5 Mew IPA Project

JPA Facet
Configure JPA settings.

Platform

[[RAD JPA S0 Piatiorm —

JPA implementation

Type: | Library Prowided by Target Runtime vl

The targeted runtime is able to provide the library regquired by this facet. Selecting this
opticn will configure the project to use that library.

Connection

[New DBZ2 for Linux, WUMNIX, and wWindows v]

Add connecticn

Conn

[ Aadd driver librarny to build path

Persistent class management
) Discower annctated classes automatical ly
@ Annotated classes must be listed in persistence.=xml

[] Create mapping file (ormoaaml)

::/"_3‘)] | < Back

o

£ > [ Finish ] | Cancel
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12. JPATest OfZ2|A0|M Q| 7|2 ZEHMETI HdE AS =QIgL Lt 222 DBO|AM BHSO0{ZT Table
2 7|Hte 2 X522 JPAZHE Entity classE M43st7| 5l OA & 28510 JPA Tools > Generate

Entities from Table
(JPAE MH5t=

St CHE HHHE2 JPA Programming

s2
Chosst

L Project Explorer £32 = = I gl === @l server xml
- |I=> JPATest| =
A Mew
Go Into

Alt=Shift="W »

Copy Ctrl=C
Copy Qualified Name
Paste

Delete

Crrl=w
Delete

Remowe from vhenck Ctri=Alt=Shift+ Down

Build Path »
Refactor Alt=Shift=T »

Import. .
Export...

Exg
==

Build Project

Refresh F5S

i

Close Project
Close Unrelated Projects

L “alidate
E Data Soury Show in Remote Systems wview
Run As

Debug As

Profile As

&= Databd
g4 rie

&= ODA I Team

TY¥YYvsw

Compare With

Restore from Local History...
Java EE Tools

Source

Configure

JPA Tools

Properties Alt+Enter

13. Entities OFRAZ} LI
L2 Lt

O|™0| BH= connection2 M

Ot O] 7| M= Table 7|HFS 2 EntitiesE
20|7| 20 CIE XI2E *t1

TYTYTUY

BIEL YAS HAER A

Hhel 2 LIch)

AN

1BHA| 7]

4] TestServl et java =3

saper ()

ftected woid doGet (HttpSerwvletReguest =
ServlietCutputStream oubt — response.gel

response  setContentType ("text /html™)
ourt .println("<htmis><hecad><ticle>Heael
out .println { "<body> >Hello World =1
out . .println ("< /html>") ;

s=e HotpServliet#doPost (HotpServlietReo:

ftected woid doPost (HotpSerwvlecReguest

OD0 Buto—generated me

od stub

£

ings. o others .
- Resource
Is (2 items)

Generate Tables from Entities .
Generate Entities from Tables...
Configure 1PA Entities

Configure Project for JDBC Deployment...

Schema®} Tableg MEHSIT

f&¥] Generate Custormnm Entities

Select Tables

Select tables to generate entities from.

Connecktion: |Ne-w DB2 for Linusx, URDX, and Windows

(Mote: Wou must hawe an active connection to select schema.}

Schema:

[ET==

Tables: AT

CATALCHG
CL_SCHED
CUSTOMER
DEBZ2ACCOUNT
DEPARTMEMT
EMPLOYEE
EMIPICHS
EMPPROLACT
EMP_PHOTOS
EMP_RESUMNE
TN EMTORY
IR TRAY
ORG
BERSOIMN
PRODUCT
PRODUCTSUPELIER
PROJACT
PROJECT
PURCHASEODRDER

m

[#F] Update class list in persistence =xml

| Restore Defaults

&2

Plesxt =

1 [

Cancel

]|

Finish
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N

14 HO|2 HFBBAYEY BEZ0ME 2 CheS UL

o -

= e = tres

TN aaksler SSisssaseciealiesress
Edit a table associaticn bw sclectina it and modifring the controls in the editinag Samnel

Table associaticns

(==

Einien 10

15. Entity Generation 220 = D{7|X|¥2t =st0 Cr2g S8 Ct

=

S sono = -

= = =]
Customize Default Entity (Genaeration
Cprtionaliy

custormize aspects of entiti
tables. A

awa package should be speci

that will be generated by default from database e
e
Table mapping

Key generator:

[mone
Sequence name:

Entity access: » Ereld Broperty:

Associations e LreTault oo Eager oo Lasmye
Collectiomn propeerties hyepees @ jasea tabil Ser ¢ JAsrm il L et

] Advwans generate opticonal JPA annotations and DDL pararmeters

Cormain jowa class
Source folder: JPATest src

Backage: =

com_ibrm juwlee o=
Superclass:

INnterfaces:

et = 1 [ Einish " e |

—ancel ]

o

16. 22%3tHE =olstn 2|7} QICtH FinishE 22510 TableO| A Entity

= Generate Custorm Entities

Customizre Indivwidual Entitie s

Tables and colurmns
ED EMPLOYEE

Table mapping
Class narme: Employees
Koew genserator: [mone

Sequence narme:

Entity access: @ Eield

Domain jawa class
Superclass: jawa lang. Cblect Browwse. . ]
Interfaces:

Achd

Jeoct = L Einish " | —ancel |




ALK AT NS, | olC g i AH A =2
17. YHXo 2 MEto| X0| AEL|UCH SHEHI 20| TableO| X522 Entity class2 HHEl A2
ol g SIOo|at A OolA
otEta 20| =ele = USLILE
@] IPA - JPATest/src/comy/ibmsjuwles/jpa/Employee java - Eclipse
File Edit Source Refactor MNavigate Search Project Run  Window Help
=i & @ - O - G G ™ 7~ 92 F) s m g @8 8 -F - S -
[ Project Explorer £% = | = = O (= serverxmi [J] TestServietjava 1] Employeejava 23
1= JPATest 2 backage com.ibm.juwlee.ipa:
4 JPA Content
5 src ® import java.io.Serializable:[]
H3 com.ibm juwlee jpa
[0 Employee java
& Employee
&= META-INF the EMPLOYEE database table

=4 JRE System Library
=4 WebSphere Application Server W8.5 Liberty Profile [W
=& EAR Libraries

= build

JPATestEAR

B8 Deployment Descriptor: JPATestEAR

TestServietWAR

WebSphere Application Server WE.5 Liberty Profile

18. 3t OR Mapping % XEQl persistencexmlO| H|CHZ

Argg JTA data source 0|2
(07|M= X ZZto|M o2 2

@] IPA - IPATest/src/META-INF/persistence xm - Eclipse
File Edit MNavigate Search Project Run Window Help

0| JDBC Datasource®| JNDI O|&
S 0 & jdbc/db2dsE

public class Employes implements Serializable {
private static final long serialVersionUID —
@xd
private String empno:

al( TemporalIvpe.DATE)
Date birthdacte;

private

BigDecimal bonus:
private BigDecimal comm:

private short edlevel;

MAME Z42 &olst1 connection 0] A
= doF L
MEBS=E SIS

£o - B-0-Q%r BE- B> S P~ Bal Hrilvmaro .
[ Project Explorer 52 =] "_3,, | & = = B[l severxml | 1] TestServietjava 7] Emplayeejava + persistencexm| &2 =l |
= JPATest : e
4 IPA Content Connection s
o persistence xml Persistence Unit Connection
& ) JPATest Configure the data source or JDBC connection properties.
(@ sre
=) JRE System Library Transaction type: lDefauIt (JTA) -
=4 WebSphere Application Server V8.5 Liberty Profile [W. Ditabiate
=i, EAR Libraries
& build ITA data source: jdbe/db2ds|
% JPATeStEAR
& TestServletWAR
1= WebSphere Application Server V8.5 Liberty Profile JDBC connection properties
i i ] + || General | connection Cptlons‘l'?ropertles Source
= = = = e = = =
[®] serverxml Ill TestServiet java + persistencexml 22 . @ Hello World [4] SearchiPAServiet java (|
<?xml version="1.0" encoding="UTF-8"?> =
< xmins:xsi="htip://wwv.v3.0xrg/ 2001/ XM
</persistence—
</persistencer
24 kel AEEZE 9|5 = KIS ™HALE el ol
19. O|E A SA| |~EZS flct JPA Sample OfZ2|H 0| A dE YSH2 2t=zotel A YLCh

-10 -
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3) JPA Sample HIAE

1 Xlg 7tX| ZHE JPA Sample OiZ2|H0|HS HAEDSHY| {510 ZtESHA 34 @ Z=MHE

—

i

StLf
gL L.

= IPA - WebSphere Application Server W85 Liberty Profile/servers/server2/server <ml — Eclipse

Eile Edit MNawvigate Search Project Run  wWindow Help
= | leva F - O - o - s o - <= - Sy g 57 o Ep= B == e
[ Li— Project Explorer =2 ) = x| = — = (3 || =l serverxml =2 [@] TestServlet jawa 1 [@1 Employee jawa
= JPATest — _ _ B
- St G B Server CTonfiguration: server2 (server <xml)
- 2= TestServietwiaR - -
== websSphere Application Server Wwa.S Liberty Profile e e e 1= =l
Il cefine the main contente af fha confioaicatinn o thic
[ » | FF | Project. .
A= Shift=w » s oSG Aapplication Project
== OSGi Bundle Project
ed rame = | Aapplication Client Project
&Y  Connector Project
& Dynamic Web Project
= S5 EJB Project
o = Enterprise Aapplication Project
b=ty JPA Project
=3 = =% Static web Project
(=78 web Fragment Project
=g wweb Project
i | Example
== — I " Dresign | Seurc| 5 | Other. Crl - P i
e e s e e E e et ]
Drmanm e ok o jo ot
et e o e e I I oy N i e o Sl e el TR ey S i e e R T B s sl s i o o I e R e [ 9
Project manne: IR T eSS R
Project location
5] se default locaticn
ocati e rsers = s=
Target runsirme
WebSphere S = =
Dynamic web module wersicon
[=o< =
Configuration
e e e e e e T T e T B P e =10 [ PEeY Ty re. 1

A good starting point for working with wWebSphere Application Server W S Liberty Profile runtirme.
Additicnal facots can lotor be installed to add neow functiconality to the projoct.

Ear mermbershis

] Aadca project to an EAaR

EaR projoct marmo: JBATostEAR - Frcws Drojoct
Mo rking sets

[ avdd Project To working sets

= [E et = 1 Einish

1=

[ =ancer ]

2. SO X @ ZZHENM JPA Sample OZ2|H 0|4 E 2ESHE Servlets AdgtL(ct

I8 Java EE - WebSphere Applicaticn Server WB.5 Liberty Profilesservers/server2/server.xml - Eclipse
File Edit MNawvigate Search Project Run  window Help
el | B i -  @@rE - @ @R B S

.T'-? Enterprise E el ~r_,"_? Services| T O || [ serverxml 22 ™ [T] TestServietjava
_ El 5 22 7__.| Be Server Configuration: server? (server.xr
. =2 IPATest 1

- B IPATestEAR

a Z IPATestWAR

[¥] Employee jav

Configuration Structure

AB JAX-WS Web Services Drefine the main contents of the configuration in this sectic
4 ‘GEE JPATestWAR —
= BBs type filter text
> Eﬁ Filter Mappings £ Server Configuration
[+ :;ia F!|tE'F5 [lci"r.l s =R}
“@ Listener HTTP fAE s ol =
&1 References =2
> fm Security roles L oj=2|17401-4 2L E 2
[ "—:%2 Servlet Mappings W Do Soj=Eg g
& Serviets! | VI Al_Mata Sonrce idbeidb2de
B =B Java Resc—ui Pleww L3 | CY%  Project..

=, JavaScript Resources
= WebContent
& TestServlietWAR
. L=+ WebSphere Application Server W8.5 LI

Serviet

dQ

Servlet Mapping

CY Example..
Y | Other Ctrl+M

-11 -
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r.—"l Create Serviet ?
Create Serviet == ?_V.' L
Specify class file destination. @
Eroject: IPATestWAR == |

Source folder: WPATestWARMSIC
lava package: com.ibm juwlee jpa Browse. .

Class name: SearchlPAServiet

Superclass: javax. servliet http. HittpServliet Browse. .

[ Use an existing Serviet class or JSP

S5 Marie SearchiPAServiet Browwse..

Mlext = i [ Finish J | Cancel

9
[as]

protected veoid doGet (HttpServletRequest regquest, HrtpServletResponse response) throws ServletException, IC
ServletOutputStream cut = response.getOutputStream():
response.setContentType ("text/html") ;
out.println("<html><head»<titlerHello World</titlex</head>");
out.println("<bodyr<hl>Hello World!!!</hlx<br>");

try {
Employee e = SearchEmployee ("000010");
out.println("Hello "™ + e.getFirstome());
} catch (Exception e} {
ri Auto-generated catch block

e.printStacklrace();

out.println("</html>"); |

BPerziszstencelnit (unitName = "JEATe=st")
private EntityManagerFactory emf:

private javax.transaction.UserTransaction utx;

protected Emnployee SearchEmplovee (String EmpNo) throws Exception {
utx.begin():
EntityManager em = emf.createEntityManager() -

Enployee employves = (Emplovee) em.find (Employvee.class, EmpNo) »
if (employee == mmll) {
utx.commit () ;7
em.claose ()
throw new Exception ("Employee is not found... EmpMNo i= " + EmpNo)»

utx.commit ()
em.cloze () ;
retorn enployee;

-12 -
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3. sl OHE2IAH OIS WASO| Bi=5L7| 95t ZSOIT Z2HES [E LE o

8] Java EE - JPATest/src/META-INF/persistence xml - Eclipse
File Edit Mavigate Search Prcuect Run WmI:.lDw Help

i T = e :—' ject
i | & 3 Open Projec
Close Proj

m

1

Enterpnse E EJE ‘t‘.:‘ Seny

E{.@' i

Build All Ctrl+B

I~ Jl
& 1PATest Build Project
&2 JPATestEAR Build Working Set v
& JPATestWAR Clean . |

AP JAK-WS Web Servicy
‘g JPATestWAR

E lava Resources @] Generate Javadoc...
2 src |
# com.ibm juw| Properties :

Build Automatically

4. YCE| O Z2|7 0| M2 IBM WAS Liberty Profile 0f BjZ&}L|C}.

b n g e v -

Drescription: Peww
» MManaged Classes open Es
— - Showw In Alt-shift=w"
» ML Mapping Files
» JAR Files = ||| e Ctrl+C
Paste CErl =2
> Drelete Drelete
Rename F2
F*=  Debug CtrieAltsD
©» start Ctri+Alt+R
B Profile
= Stop Ctrl=Alt=S
Eis Publish Ctrl=Alt-P
Clean.

ey Add and Remowe. .

Monitoring
| Gene-ral Connection C}pticbns’ Properties Clean Server on MNext Start
L Marlcers: E2 Properties s Servers = Utilities
Eﬂ Web Preview Server [=t Properties Alt=Enter

- |% W-ebSphere Applicat
- TestServietWar L

=

= B Server Configuration

3

3

>

Mowe rescurces to the right to configure them on the server

SAovailable: Configured:

& JPATestWAR (0 42aFestsAar
e TestServietWwaR

i Add Al = > ]

l == Remowe All ]

[&F] If server is started, publish changes immediately

=2}

)
o1}
o
T

Mlext = [ Finish J | Cancel

& Add and Remowve... | | >
Add and Remowve =—
mrodify the rescurces that are configured on the server —

§tion5

=

OIS POCSTT TS T S e T IS OO e, S T fanlze-d]

-13 -
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5. H{Z7} A2 EH HAEE

Persistence provider:
Description:

» Managed Classes
» XML Mapping Files

» JAR Files

; General | Ccmnectlcm Dpt|0n5| Properhes. Source

[ﬁ_ Markers El Properties | $?$ Servers EE

.j"E, Web Preview Server
==

LSTop

5 'EI JPATestEAR
{ o TestServietWaR |

‘E Server Configuration [server.x

ﬁ Data Source Explorer E5 Snippets

WebSphere Appllc,atlon Serve-r V85 leert)r Profile at localhost [server2] [Stopped, SYNChTonizaa]]

2510 IBM WAS Liberty Profileg

AIZE A LT

Mew

Open
Show In
Copy
Paste
Delete
Rename

Debug
Start

Frofile

Stop

Publish

Clean...

Monitering

Clean Server on Mext Start

Utilities

Properties

Add and Remowe.

F3
Alt+Shift+w

-

Ctrl+C
Ctrl+V
Delete

F2

Ctrl=Alt+D
Ctrl=Alt+R

Alt+

Ctrl=
Ctrl+Alt+P

Alt+Enter

=2l5}0 Run As > Run on ServerE

[l serverxml

2510 sie

| [3] SearchiPAServietjava

6. HAEE 28|M THEO{F Servlett A 0O}
o ABHDS
Servletg gLt
4® Enterprise E 52 I i ' i &
s erprise 75 Services | || ] serverxml ||1] TestServletjava + persistencexm| 3
[ = & @ =
- B2 % | General
» 2 IPATest |
¢ = JPATestEAR | General
a T pATectWAR 1
AP JAX-WS Web Services New k
¢ 'ma JPATestWAR -
Open Type Hierarch F4
4 28 Java Resources pen 1yp ¥
4 (2 src Show In Alt=+Shift+W »
4 {3 comibmjuwleejpa Open F3
¥ '_|1| SearchlPAServiet) Open With 3
» i Libraries
=i, JavaScript Resources Copy Cirl+C
&= WebContent Copy Qualified Name
b 2 TestServietWAR % Paste Crl=v
p» 5= WebSphere Application Server %  Delete Delete
Remove from Context Ctrl+ Alt+Shift+ Down
Build Path »
Source Alt+Shift+5 »
Refactor Alt=Shift«T »
ey Import.
iy Export..
&1 Refresh &
References »
Declarations 4
Run As »
Debug As »
Profile As »
Validate

l:
+5 1 Run on Server

=

S RPN S PRt - T~ SRR <153 e T WO Y SRR [ — PO W I S SV

Alt+Shift+X, R

L0 2 Run on Mobile Browser Simulator

Run Configurations...
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Stetnb ZHo] MAFM o2 DB7} X3|E0A SIEHA 2 LtQ D JPA Sample HAEJ} AZXoz Az}
(o)

[&] serverxml | [1] TestServiet java 8 persistence xml @ Hello World 5 [J] SearchipAServietjava | = 'EE C

® &  hitp//localhost:9080/IPATestWAR/ SearchPAServlet - b e

Hello World!!!

Hello CHRISTINE

SESN0172T: Ml ZR2ITI2F MM 1D MAE 23l Java 7|2 SecureRandom RHE AFE E2ULICH
SRVEQ242I: [JPATestEAR] [/JPATestWAR] [com.ibm.juwlee.jpa.SearchJPAServlet]: Z2(EIE Zt2#SUICH

[INFO
[INFO

(21 Markers | T Properties | <# Servers |8 Data Source Explorer | [i=1 Snippets | T Annotations | B Console 32 3 Progress | ]
WebSphere Application Server V8.5 Liberty Profile [server2] (72 4, 2012 9:59:39 27H)
[AUDIT ] CWWeTooi1eI:  HEZIHIOIM ALE J‘Pécdefa-ﬂc_hosc—]: http://localhost: 3080/TestServlecWAR/ *
[INFO ] SRVES9S2I: TestServlietWaR HE2|AHI0[H0| & HHIO|SH E2=|HSLICH
[AUDIT ] CWWEZ0001I: 0.60%E =M IHEZ|H0IM Testserviecward| (?h AIZFELICE.
[INFO 1 cWWEF0008I: 2|5 HHl0IEX 5. 093E 0| 22T ELICH
[RUDIT ] CWWEFOO11I: server2 AHI A0 EMHE 4¥E ZH(0FTIFSLUICEH
[INFO 1 SESNE501I: MM ZRIZEDFEISE AR #IAIE A EHSUCH HttpSession ZEREDZE IHE2IAHIOIA AHE HIZ2IH HEELICEH
[INFO 1 SESNO176I: default host/JPATestWaR HE2IHIOIM M| CHEF M HIHA AL AED ZHEEILICEH
1
1
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4)

O|tH Z =AM IBM WAS V8.5 Liberty profileg £t JPA Sample HIAEE 3 St &SL|LCH

my
rhu

JPA T2 RHIF T2 OIS SEX|T O] ZAE i IBM WAS Liberty ProfileZ 0|&3}0f
JPA O ZE[A0ldE Adgotn 2Fote A2 AT OFX| FsHCh 285 A= 23S SN
SOl 2AX|T JPA 7|5 FI15IEH LA 222 JDBC HAEQL A %!?:.*LIEF CHAl EEEE A

Hesto] &~ HzE?

O3 Ol Zxt= OFRE(5t ChE HZHE Sl IBM WAS V859| Lot TES O THLIEEZE SiAE
L|C}. Go Go !t
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9) 1 X=

1.

0| 7}0|E= IBM WAS V8.5 %X ALEAIE Q|3 7|2 Jt0|E QL|Ct

IBM WAS X0 OFE Ql43ix| oAl 252 7138 7|2afel LM 27 wat sre

IBM WAS v7' Z4HE BIF Qi1 0 ZAtE oAl Zo| WM ofsjo| Euct.

72X IBM WAS V8.5 InfoCenterQ| S| ZIH|D2|E oF H A0{E 10 L =0 ZAHSIA| 7| Hi2}

ALt

InfoCenter — WebSphere Application Server V8.5
(http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/index.jsp)

InfoCenter — JPA for WebSphere Application Server
(http://pic.dhe.ibm.com/infocenter/wasinfo/v8r5/topic/com.ibm.websphere.base.doc/ae/cejb_jpan
ote.html?resultof=%22%6a%70%61%22%20)
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